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1. Warning

EcuTek ProECU tuning tools should only be used by experienced tuners who understand the
product and engine calibration.

If you do not fully understand this product then you WILL damage your engine, ECU or your
vehicle.

Please ensure you fully read all EcuTek manuals BEFORE attempting to use ProECU with your
laptop or your vehicle.

Use with extreme caution and understanding, at all times, if in doubt then do not proceed.

EcuTek accepts no responsibility for any damage to the engine, ECU or any part of the vehicle
that results directly or indirectly from using the product.

** |f you are in any doubt that you do NOT have the experienced required to use this product
then you should NOT USE IT **

Retail customers

** If you have any doubt that you do NOT have the experienced required to use this product
then you should NOT USE IT, you should simply contact your EcuTek Master Tuner shown
clearly on the top of your Programming Kit or visit your preferred tuning shop to have a
professional tuner to use it for you **
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2. Introduction

ProECU for BMW N55 supports F-series models with the N55 engine including but not
exclusively 235, 335, 435, 535, x5 and other models equipped with the single turbo 3.0 engine.

ProECU provides OBD unlock, ROM editing, ROM programming, data logging, data analysis
and diagnostic tools in one single software suite.

ProECU provides robust security for tuners wishing to create in depth tunes that use more than
the bare minimum of maps. Tuned ROM files can be locked to a specific VIN and/or a specific
customer (using the ID of their USB security key)
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3. Tuning Workflow

Overview

Unlike other EcuTek tuning solutions, a two-step process is required to begin tuning.

The first step is to unlock the ECU, the EcuTek licence and is also installed during this process,
but it only needs to be done once, using a green EcuTek CAN cable this can take around 18
minutes.

Once unlocked, tuning is the same as most EcuTek platforms and a tuned ROM can be
programmed. At the point of initial release this takes about 2m30s using a CAN cable.

Datalogging the tuned ROM to check key parameters can then be carried out. Depending on
the nature of the tuning the tuned ROM can be updated and retested until the tuner is happy
with the results contained with the logs.

Unlock ECU and Program tuned Datalog and
install license ROM file analyse results
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4. ECU Unlock

The unlock process is only required the first time the ECU is programmed from stock. It allows
programming of non-OEM ROM files, adds EcuTek licencing information and secures the ECU
against reading by third party tools.

Detect or

Select Unlock and

install . Clear DTCs

ECU Unlock Load
Tool & . Matching
Query ECU Stock ROM

Vehcle or

ECU licence

Preparing for unlocking

e Ensure laptop that has sufficient charge to last the unlock process.

e The car battery will also need to be in good condition

e Lights, blower, ICE switched OFF!

e Ifin any doubt you may want to use a low current battery charger on the car

e BEWARE OF USING CAR BATTERY CHARGER AND MAINS POWERED LAPTOP
SIMULTANEOUSLY. MAINS VOLTAGE GROUND LOOPS CAN BE CREATED IN

e To prevent the BCM switching the ignition off automatically during a long unlock
operation, keep the driver’s door open before switching on ignition, then keep the door
open until the unlock process is complete.

Getting Connected
Connect EcuTek Interface cable to USB port of PC and OBD port start ProECU.

£

ProECU 68A
TB 8C

Click on the “Tools” menu and select “Detect Vehicle”

= O >
| Eile Tooks Options Window: Help | RecentROMs | Recers oo | |IEGURGICANIREHSGeIDICONI)] NFURdIELineIneitsce (D1500000009)]

Identify ECU...

Detect Vehicle...

Manually Select Vehicle...
Manually Select Single ECLL..

“ @ Detecting Vehicle ECUs. Please wait..
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Some tuners may prefer to manually select the vehicle type:

ProECU

= O x
File Tools Options Windows Help | RecentROMs| RecentLogs| _—
Identify ECLL...
Detect Vehicle...
ManuallySelect\iel}:le... - =
Manually Select Single ECU... fzzaiiares

W A
Horle CAN

Mazda 3 DISI -=2010MY
Mazda & DISI -=2010MY
Mazda 8/MPV DISI -» 2070MY
Mazda CX7 DISI -= 2010MY
Mazda DISI 2000MY-=

Pdazra BAY_S _ Gencratinm 2 W

OK Cancel

After the vehicle or ECU is detected or selected, the next step is chosen, the default option is
set to “Program Engine ECU” but if connecting to unlock the ECU select “ECU Unlock Tool”:

Select Tuning Tool
Vehicle:

Select Tuning Tool
Vehicle:

BMW MEVD17 vehicle BMW MEVD17 vehicle

Includes the following ECUs: Includes the following ECUs:

BMW MEVD17 ECU BMW MEVD1T ECU
Select an operation to perform from the list below,
Mote: These options are also now accessible from the
tools menu

Program Engine ECU

Program Engine ECU
ECUDTC Tool - BMW MEVD17 ECU ECU DTC Tool - BMW MEVD1T7 ECU
ECU Unlock Tool

Vehicle DTC Tool - EMW MEVD1T vehicle Vehicle DTC Tool - BMW&EVDﬂvehicle

OK Cancel |

Select an operation to perform from the list below.
Mote: These options are also now accessible from the
tools menu

oK | Cancel
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Once the ECU unlock tool has opened, click on “Query ECU” and the ECU will be detected, and
its components reported:

BMW ME ECU Unlock Tool

BHMW MEVD17 ECU Unlock Tool
Detected VIN: WER
Detected ECU Serial: 01

Detected ECU hardware wversion: Q000130DE-001-015-001
Detected ECU bootloader wersion: 000015DC-001-0£3-001
Detected ECU software version: 00002157-025-1€0-001
Detected ECU calibkration: 2 —-023-1€0-003
Detected ECU coding: QO0000B0R-000-046-001

10000 Flash Points currently on licence key.

Query U Unlock ECU Read DTC

Load ROM Back To Stock Clear DTC

Ready

Click on “Load ROM” and you will be prompted to select a 100% unmodified ROM file. The
dialog box will be prefilled with the correct ROM, you should be able to click on “Open” or just hit
the “Enter” key.

=
N » ThisPC » OS(C) » EcuTek » ProECURomFifés » BMW v Search BMW 2
Organise + Mew folder =« [ o
~ Mame Date modified Type Size ~
¥ 00001A28-029-140-001-enc.bin 09 EcuTek ROM File 4100 KB
¥ 00001BB0-029-140-016-enc.hin 09/ EcuTek ROM File 4100 KB
¥ 00001BB0-029-160-003-enc.hin EcuTek ROM File 4100 KB
& OncDrive - EcuTd ¥ 00001BB0-029-170-002-enc.bin EcuTek ROM File 4100 KB
nevnve - teule B 00001BE0-029-170-003-enc.bin EcuTek ROM File 4,100 KB
[ This PC ¥ 00001BB0-029-180-004-enc.hin EcuTek ROM File 4100 KB
“J 30 Objects ¥ 00001BB4-029-140-016-enc.hin EcuTek ROM File 4100 KB
B Desktop ¥ 00001BB4-029-160-003-enc.bin EcuTek ROM File 4100 KB
8o . ¥ 00001BB4-029-170-002-enc.hin EcuTek ROM File 4100 KB
=] ocuments
¥ 00001BB4-029-170-003-enc.bin EcuTek ROM File 4100 KB
¥ Downloads B 00001BB4-029-130-004-enc.bin EcuTek ROM File 4100 KB
J Music ¥ 00001ED3-029-140-016-enc.bin EcuTek ROM File 4100 KB
=] Pictures ¥ 00001ED3-029-160-003-enc.hin EcuTek ROM File 4100 KB
B videos ¥ 00001ED3-029-170-002-enc.hin EcuTek ROM File 4100 KB
22 05 (C) ¥ 00001ED3-029-170-003-enc.bin EcuTek ROM File 4100 KB
2 B nONNTFNA-N26-180-0d-enr hin MaAN2AN148 11-24 FruTel RMKA File A1 KR 2
File name: [[[[IZDDC-DZQ-‘IGD-([B-enc.hin ~
[
Ready
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If the file is successfully loaded, the progress window will be updated, and the licence status will

be reported:

U Unlock

BiW MEVD17 ECU Unlock Tool
Detected VIN: WBRL L
Detected ECU Serial:

Detected ECU hardware wversion:
Detected ECU bkootloader version:
Detected ECU software version:

Q0001SDE-001-015-001
Q00013DC-001-0€9-001
00002157-029-1€0-001

Detected ECU calikration: 000020DC-029-1€0-003

Detected ECU coding: Q0000BOR-000-04€-001

10000 Flash Points currently on licence key.

User clicked "Load RCM"™

Loaded ROM from C:\EcuTek\ProECURomFiles\BMW\000020DC-025-1€0-003-enc.bin
Found patch wersion 342€l1 for boot loader 000015DC-001-0€9-001

Created patched boot loader

Unlocking this ECU will consume 200 Flash Points.

Putting an ECU back to stock is free of charge.

Query ECU Unlock ECU Read DTC

Load ROM Back To Stock Clear DTC

Ready

You are now ready to proceed with the unlock process. Click on “Unlock ECU” and progress will
begin. This typically takes around 18 minutes, it is normal for the low pressure fuel pump to run.

U Unlock
Detected ECU bootloader wersiom: 000015DC-001-0&£5-001 L]
Detected ECU software wversion: 00002157-029-1€0-001

Detected ECU calibration: 000020DC-029-1€0-003
Detected ECU coding: Q0000BOA-000-048-001
10000 Flash Points currently on licence key.

User clicked "Load ROM™

Loaded ROM from C:‘\EcuTek\ProECURomFiles\BMW\000020DC-025-1€0-003-enc.bin
Found patch wersion 342€1 for boot loader 000013DC-001-0€9-001
Created patched boot loader

Unlocking this ECU will consume 300 Flash Points.
Putting an ECU back to stock is free of charge.

User clicked "Unlock ECU™

Backing up wehicle coding

Found wehicle coding

ECU reset

300 Flash Points used - now 3700 Flash Points remaining.
Erase bootloader

Reflash bootloader

Bootloader Signature

ECU reset

Detected VIN: WBA3T3

Detected ECU Serial: 01

Detected ECU hardware wversion: 00001SDE-00L-015-001
Detected ECU bootloader wversion: 000015DC-001-0&£5-001
Erase bootloader

Reflash bootloader

Bootloader Signature

Reflash code

Query ECU Unlock ECU Read OTC

Load ROM Back To Stock Clear DTC

Transferring Data. Progress 6%
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When the unlock process is complete the ECU will be reset and DTCs cleared. Cycle the
ignition by turning off for a few seconds and then back on to restart all the other modules on the
car.

BMW MEVD17 ECU Unlock Tool

Unlocking this ECU will consume 300 Flash Points. -~
Putting an ECU back to stock is free of charge.
User clicked "Unlock ECU™
Backing up wehicle coding
Found wehicle coding
ECU reset
300 Flash Points used - now 3700 Flash Points remaining.
Erase bootloader
Reflash bootloader
Bootloader Signature
ECU reset
Detected VIN: WBA3T:
Detected ECU Serial: 017
Detected ECU hardware wversion: 0000158DE-001-015-001
Detected ECU bootloader wersiom: 000015DC-001-0£5-001
Erase bootloader
Reflash bootloader
Bootloader Signature
Reflash code
Reflash maps
Performing DIC Operations on BMW MEVDL7 ECT ...

Clearing DICs. ..
How cycle the ignition to ensure codes are cleared

DTCs Cleared.
Clearing DTCs Completed.
End of DTIC Operations on BMW MEVD17 ECU ...

ECU Unlock Complete. Please cycle the ignition

Query ECU Unlock ECU Read DTC

Load ROM Back To Stock Clear DTC

Ready

ECU Unlock Troubleshooting

e |n some cases, it may be necessary to do a second vehicle-wide clear DTC operation
after the ECU unlock process and/or an additional ignition power cycle.

o |f for whatever reason unlocking is interrupted or fails, it should be possible to restart the
process without issue.

e After an unlock failure, it is possible the ECU is partly blank and will not communicate
using normal OBD commands, thus the vehicle cannot be detected. If you close and re-
open ProECU for whatever reason (eg laptop ran out of battery) you will need to
manually select the vehicle, do not rely on autodetect.

e If restarting an unsuccessful ECU unlock operation, it is possible (but rare) the ECU will
have been left without an EcuTek licence. If this should occur, please use an additional
license and contact EcuTek support to get your licence points balance corrected.
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Introduction

5. ROM Editing

ProECU for tuners provides comprehensive ROM editing tools. You can start by opening a
ROM from the “File” menu in ProECU.

ProECU

File Tools Options ‘Windows Help | Recent ROMs
Open ROM File... k

Recent ROMs
Find ROM...

Compare ROM Files...

Open Log File...
Recent Logs
Find Log File...
Merge Log files..,

View Flash Log File...
Save Screenshot to file..

Exit

Fo

RecentLogs |

= O *

Alternatively, you can drag’n’drop the ROM file of your choice from a windows explorer window.
ROM files are located in vehicle specific subfolders of C:\Ecutet\ProECURomFiles

€ o v

B BMWO00001.bin

& 000042EB-019-060-038-enc.bin
% 000042EB-019-060-037-enc.bin
% 00002F00-0719-060-037-enc.bin
§ 00002F00-019-060-038-enc.bin

£

1,030 items

» ThisPC » OS5(C) » EcuTek » ProECURomFiles » BMW

E 00002DFE-019-060-038-enc.bin
&€ 00002DFE-019-060-037-enc.bin
& 00002DFC-019-060-037-enc.bin
3 00002DFC-019-060-038-enc.bin
&E 00002DFA-019-060-038-enc.hin

v @ Search B yel

B 00002DFA-019-060-037
B 000042EB-019-040-035
3 000042EB-019-040-025
B 000042EB-019-040-028
B 00002F00-019-040-026-
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Once your ROM file is open, you can navigate through the maps available for calibration.

A ProECU

- O X

| Eile Tools Options Windows He|p| Recent ROM

s |

A ROM - 00002A47-029-180-004-enc.bin (0DD02A47-023

| File View Colouring Loggingl

04 - N..

— O

i@ Map Access
Maps  Live Data Keying RaceROM Live Graphs

MName
Idle Control

=-Ignition Timing
Base

@ Log to File @ Auto Logging

Log Mark 0

U Ignition Base Timing - Coked - Path 1
U Ignition Base Timing - Cold - Path 1
U lanition Base Timina - Cold - Path 2

..... AAT-029-180-004-enc.bin - Ignition Base Timing - Warm - Path 1

File Edit View Plot Help

i
[
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e
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wn
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x

enc.bin - Torque Max -

Open L File Edit View Plot Help
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To get started tuning, check your BMW rom folder for example ROM files and read our
knowledgebase article covering a basic tune on BMW N55:

https://ecutek.zendesk.com/hc/en-gb/articles/360000508017-BMW-F-Series-435i-example-

ROM

(Tuners will need to be logged into our Zendesk portal to access this article)
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6. ECU Programming

To begin programming, click on the “Tools” pulldown menu and select “

ProECU® =

| File Tooks Qptions Help | Recent ROMs | Recent Logs | [Reund AN Intefface (1D COMS)| | Found KcLine nteiface (1D'S00000005)

Identify ECLL...

Detect Vehicle...

Manually Select Vehicle...
Manually Select Single ECU...

Vehicle OTC Tool - BMW MEVD1T vehicle

Pragram Emine ECU
ECU Unlock Tool
ECU DTC Tool - BMW MEVD1T ECU

ProECU will pre-load the last loaded or saved ROM ready for programming, if you have been
editing and saving a ROM file it will ready to program. Otherwise you can click on “Choose ROM
File” or drag a ROM file into the programming window from windows explorer.

Click on “Query ECU” to read details of the ECU connected to the PC such as the CALID and
EcuTek licence and programming information.

BMW MEVD17 ECU Programming Tools Close
ROM File to Program 12:2€:35: Date & Time: 24/10/2018 12:36:35 Version 1.0.0.343532
C:\EcuTek\ProECURomFiles\ BMW\000020D C-029- 160-003- 12:3€:35: Dongle ID: eC RE 35 5700 Flash Points currently on licence
enc.bin key-
' 12:35:35: EcuTek Vehicle Interface: Firmware 2.3.0
18:3€:35:

12:3€:35: Selected ROM File: C:\EcuTek\ProECURomFiles\BMW\000020DC-0259-180-
003-enc.bin

12:23€:35: ROM File STD: CD21€521

18:36:35: ROM File CLC: CD21%521

Drag ROM Here to Open Choose ROM File..,

Programming Sequence

uery ECU Pragram ECL 15:3€:43: gg# User Selected 'Program ECU"
Ty = g
12:3€:43: Date & Time: 24/10/2018 12:3€:42 Versiom 1.0.0.343532
. " 18:3€:43: Dongle ID: €C RE 35 5700 Flash Points currently on licence
ECU Version |000020DC-023-160-003 - N55 3 Series MT EU key
Compatible 0000200C-029-160-003 18:36:43: EcuTek Vehicle Interface: Firmware 2.3.0
ROM Files 18:3€:43:
12:35:43: VIN: WEBAI [
18:3€:43: Calibration ID = '000020DC-025-1&0-003"
12:2€:43: ECU = 000020DC-025-1€0-003 - M55 3 Series MT EU

. . . 18:3€:43: The following ROM file wersion is compatibkle with this ECU:
ECU Registration Details 000020DC-025-160-003
Comment 18:3€:43: ECU is fully programmed.
12:2€:43: ECU has been coded
Programmer ID 18:3€:52: ECU contains a EcuTek licence

Program Count

Program Date

Licences in ECU  |EcuTek Licence

Read Registration Details Check ECU Connection
Durmnp Details for EcuTek Read DTCs
Clear DTCs Save Screenshot to File

Transferring Data. Progress 33%
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7. Datalogging

To get started logging your target car, simply load a ROM into ProECU and switch to the “Live
Data” tab of the ROM window.

Most commonly used functions:

e Map Access — Initialises connection to ECU and displays live data values (Hotkey: Del)
e Log to File — If connected, starts and stops logging to file (Hotkey: Ins)

e Open Last Log — Shortcut to open the last saved logfile for analysis.

ROM - 000020DC-029-160-003-enc.bin (000020DC-029-160-003 - N

| Eile Niew Colouring Logging |

@ Map Access @ Log to File Auto Logging | Log Mark 0 | Open Last Log... Find logg
Maps LiveData Keying RaceROM  Live Graphs

Name Units  Mini... Cur... Max..
=-Logged Parameters ~
é Accelerator Position % Pedal  --- na n'a
1] Ambient Air Temperature HE === n/a nfa
1| Boost Pressure (pre-throttle) hPa --- n/a n/a
é Boost Pressure Error hPa - nfa nfa
1’| Boost Pressure Target hPa == n/a nfa
1| Coolant Temperature *C === nfa nfa
1] Engine Load Desired % === n/a n/a
1| Engine Oil Pressure hPa === n/a nfa
1| Engine Oil Temperature *C === nfa nfa
1| Engine Relative Cylinder Fill % === n/a nfa
1| Engine Speed rpm - n/a n/a
1| Engine Termperature e === nfa nfa
Exhaust Cam Angle ° Crank| --- n/a nfa
Exhaust Cam Angle Desired “Crank| --- nfa na
é Exhaust Gas Temperature After Catalyst “C - na n'a
1] Fuel Injection Quantity cylinder 1 mg/stk | --- nfa nfa
1| Fuel Mass Flow Rate kg/h =23 n/a n/a
é Fuel Rail Pressure Actual Filtered (lo-res) MPa - nfa nfa
1| Fuel Trim Long Term Bank 1 % == n/a nfa
1| Fuel Trim Short Term Bank 1 % === nfa nfa
1] Gear Actual (0-8) - --- n'a n'a
=] Ignition Timing °*Crank| --- n/a nia
11 Ignition Timing Cylinder 1 * Crank| --- nfa nfa
1] Inlet Cam Angle “Crank | --- n/a nfa
1| Inlet Cam Angle Desired * Crank| --- n/a n/a
1| Intake Air Temperature smoothed S === nfa nfa
Intake Valve Lift mm == nfa nfa
Intake Valve Lift Target mm === nfa na
é Knock Conditicn Detected i1 - na n'a
1] Lambda Actual Bank 1 = - nfa nfa
1| Lambda Target Limit Bank 1 = ==2 nfa n'a
é Manifold &bsolute Pressure (Filtered) hPa - nfa nfa
1| Mass Airflow Filtered kg/'h --- nfa nfa
1] Mass Airflow Sensor period us === nfa nfa
1] Throttle Actual - Relative to Closed Position (lo-res) % Thr.. | --- nfa nfa
1| Torque Actual at Clutch MNm === n/a nfa
1| Torque Desired for Desired Load Mrm == nfa nfa
1] Torque Desired for Gearshift MNm === n/a n/a
1] Vehicle Speed km/h === n/a n/a
1| Wastegate Duty Cycle % == nfa nfa

[=-All Parameters
L1 AfC Compressor Active 0N ==3 n/a n/a
L Accelerator Angle deg - na n'a
LI Accelerator in sport mode [ --- nfa nfa
1| Accelerator Position % Pedal| --- nfa n/a
L Accelerator Position (lo-res) % Pedal  --- nfa nfa
L Actual Injection Mode Cylinder 1 = === nfa nfa
LI Actual Injection Mode Cylinder 2 = === nfa nfa
|| Actual Injection Mode Cylinder 3 = === n/a nfa
L| Actual Injection Mode Cylinder 4 = === nfa nfa
L_| Actual Injection Mode Cylinder 5 = == nfa nfa
[] Actual Injection Mode Cylinder & = === n/a nfa
g Actual Inlet valve opening = Cramk | --- nfa nfa w

File CRC was '5463 B486' when loaded.
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8. Support

Technical support

EcuTek provides primary product support via email, support portal and telephone, from 9:00 to
18:00 UK time. Support engineers are on hand to assist you apply your tuning knowledge using
our tools, but EcuTek doesn’t provide general tuition for basic tuning skills.

We encourage our dealers to register on our Zendesk customer support portal, to more easily
submit and track support requests, and gain access to tuner-only knowledge base articles.

Go to https://ecutek.zendesk.com/hc/en-gb/ and click on “Sign In” to get started.
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